
 

Tools
Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .V
Direct Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .A
Group Selection . . . . . . . . . . . . . . . . . . . . . . . . . . . .Shift
Magic Wand . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Y
Lasso . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Q
Pen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .P
Add Anchor Point . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +
Delete Anchor Point . . . . . . . . . . . . . . . . . . . . . . . . . . . –
Convert Anchor Point. . . . . . . . . . . . . . . . . . . . . Shift+C
Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . T
Touch Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+T
Line Segment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . \
Rectangle . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . M
Ellipse . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . L
Paintbrush. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .B
Pencil . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . N
Blob Brush. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+B
Eraser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+E
Scissors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . C
Rotate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .R

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .O
Scale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . S
Width. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+W
Warp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+R
Free Transform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . E
Shape Builder . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+M
Live Paint Bucket . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .K
Live Paint Selection . . . . . . . . . . . . . . . . . . . . . . Shift+L
Perspective Grid . . . . . . . . . . . . . . . . . . . . . . . . . Shift+P
Perspective Selection. . . . . . . . . . . . . . . . . . . . . Shift+V
Mesh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .U
Gradient . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .G
Eyedropper, Measure . . . . . . . . . . . . . . . . . . . . . . . . . . . I
Blend . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . W
Symbol Sprayer. . . . . . . . . . . . . . . . . . . . . . . . . . Shift+S
Column Graph. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . J
Artboard . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+O
Slice . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+K
Hand . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .H
Zoom . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Z
Toggle Fill and Stroke. . . . . . . . . . . . . . . . . . . . . . . . . . .X
Default Fill and Stroke . . . . . . . . . . . . . . . . . . . . . . . . . .D
Swap Fill and Stroke. . . . . . . . . . . . . . . . . . . . . . Shift+X
Color. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ,
Gradient . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
None . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . /
Toggle 3 Screen Modes . . . . . . . . . . . . . . . . . . . . . . . . . F
Show/Hide All Panels. . . . . . . . . . . . . . . . . . . . . . . . . Tab
Show/Hide All But Toolbox . . . . . . . . . . . . . . Shift+Tab
Increase Diameter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ]
Decrease Diameter. . . . . . . . . . . . . . . . . . . . . . . . . . . . . [
Symbolism Tools: Increase Intensity . . . . . . . . .Shift+}
Symbolism Tools: Decrease Intensity . . . . . . . . Shift+{
Toggle Drawing Mode . . . . . . . . . . . . . . . . . . . . Shift+D

File
New . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+N
New from Template . . . . . . . . . . . . . . . . . Shift+Ctrl+N
Open . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+O
Browse in Bridge . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+O
Close . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+W
Save or Save As. . . . . . . . . . . . . Ctrl+S or Shift+Ctrl+S
Save a Copy . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+S
Save for Web. . . . . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+S
Revert . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+Z
Place . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Scripts > Other Script . . . . . . . . . . . . . . . . . . . Ctrl+F12
Package . . . . . . . . . . . . . . . . . . . . . . . .Alt+Shift+Ctrl+P
Document Setup . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+P
Document Color Mode. . . . . . . . . . . . . . . . . . . . . . . . . . .
File Info . . . . . . . . . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+I
Print . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+P
Exit. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+Q

Edit
Undo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+Z
Redo. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+Z
Cut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+X
Copy . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+C
Paste . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+V
Paste in Front . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+F
Paste in Back. . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+B
Paste in Place . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+V
Paste on All Artboards . . . . . . . . . . . .Alt+Shift+Ctrl+V
Clear. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Find and Replace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Find Next. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Check Spelling . . . . . . . . . . . . . . . . . . . . . . . . . . . .Ctrl+I
Edit Custom Dictionary . . . . . . . . . . . . . . . . . . . . . . . . . .
Edit Colors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Convert to CMYK. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Convert to RGB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Edit Original . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Color Settings . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+K
Keyboard Shortcuts . . . . . . . . . . . . . .Alt+Shift+Ctrl+K
Preferences > General. . . . . . . . . . . . . . . . . . . . . Ctrl+K

Object
Transform Again. . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+D
Transform Each. . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+D
Move . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+M
Rotate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Scale . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Shear . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Reset Bounding Box. . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Object > Arrange >
Bring to Front . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+]
Bring Forward. . . . . . . . . . . . . . . . . . . . . . . . . . . . .Ctrl+]
Send Backward. . . . . . . . . . . . . . . . . . . . . . . . . . . .Ctrl+[
Send to Back . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+[
Send to Current Layer . . . . . . . . . . . . . . . . . . . . . . . . . . .
Group. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+G
Ungroup . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+G
Lock > Selection . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+2
Unlock All . . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+2
Hide > Selection . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+3
Show All . . . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+3
Expand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Expand Appearance . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Path > Join . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Ctrl+J
Average . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Alt+Ctrl+J
Outline Stroke. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Simplify . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Add Anchor Points . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Remove Anchor Points. . . . . . . . . . . . . . . . . . . . . . . . . . .
Divide Objects Below . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Split Into Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Clean Up . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Blend > Make  . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+B
Blend > Release  . . . . . . . . . . . . . . . Alt+Shift+Ctrl+B
Blend Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  
Make with Warp. . . . . . . . . . . . . . . . Alt+Shift+Ctrl+W
Make with Mesh. . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+M
Make with Top Object . . . . . . . . . . . . . . . . . Alt+Ctrl+C
Envelope Distort > Release. . . . . . . . . . . . . . . . . . . . . . .
Edit Contents  . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+P
Live Paint > Make . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+X
LiveTrace > Make . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Text Wrap > Make . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Text Wrap > Release . . . . . . . . . . . . . . . . . . . . . . . . . . . .

 . . . . . . . . . . . . . . . . . . . . . .
Clipping Mask > Make. . . . . . . . . . . . . . . . . . . . . Ctrl+7
Clipping Mask > Release. . . . . . . . . . . . . . . Alt+Ctrl+7
Compound Path > Make. . . . . . . . . . . . . . . . . . . Ctrl+8
Compound Path > Release . . . . . . . .Alt+Shift+Ctrl+8
Convert to Artboards . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Graphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Other Object
Lock Others . . . . . . . . . . . . . . . . . . . . .Alt+Shift+Ctrl+2
Hide Others . . . . . . . . . . . . . . . . . . . . .Alt+Shift+Ctrl+3

 . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+4
Average & Join . . . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+J
Isolate Selected Object . . . . . . . . . . . . . . . . . . . . . . . . . .
Enter Isolation Mode . . . . . . . . . . . . . . . . . Double-click
Exit Isolation Mode . . . . . . . . . Double-click or Escape

Type
Glyphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Area Type Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Type on a Path Options . . . . . . . . . . . . . . . . . . . . . . . . . .
Create Outlines . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+O
Find Font . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Change Case > UPPERCASE. . . . . . . . . . . . . . . . . . . . . . .
Change Case > lowercase . . . . . . . . . . . . . . . . . . . . . . . .
Change Case > Title Case . . . . . . . . . . . . . . . . . . . . . . . .
Change Case > Sentence case . . . . . . . . . . . . . . . . . . . .
Smart Punctuation
Show Hidden Characters . . . . . . . . . . . . . . . .Alt+Ctrl+I
Type Orientation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Select
All. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+A
All on Active Artboard . . . . . . . . . . . . . . . . . Alt+Ctrl+A
Deselect. . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+A
Reselect  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+6
Inverse. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Next Object Above . . . . . . . . . . . . . . . . . . . . .Alt+Ctrl+]
Next Object Below . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+[
Select > Same . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Other Select
Switch Selection Tools . . . . . . . . . . . . . . . Alt+Ctrl+Tab
Navigate to Next Document . . . . . . . . . . . . . . . Ctrl+F6
Navigate to Previous Document . . . . . . Shift+Ctrl+F6
Navigate to Next Document Group . . . . . Alt+Ctrl+F6
Nav. to Previous Doc. Group . . . . . .Alt+Shift+Ctrl+F6

 . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+E
. . . . . . . . . . . . . . . . . . . . . .Alt+Shift+Ctrl+E

 . . . . . . . . . . . . . . . . .

View
Outline or Preview . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+Y
Overprint Preview . . . . . . . . . . . . . . .Alt+Shift+Ctrl+Y
Pixel Preview . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+Y
Zoom In . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Ctrl+=
Zoom Out . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+-
Fit Artboard in Window. . . . . . . . . . . . . . . . . . . . Ctrl+0
Fit All in Window . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+0
Actual Size. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+1
Show or Hide Edges . . . . . . . . . . . . . . . . . . . . . . . Ctrl+H
Show or Hide Artboard . . . . . . . . . . . . . . Shift+Ctrl+H
Show or Hide Print Tiling. . . . . . . . . . . . . . . . . . . . . . . . .
Show Template. . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+W
Show or Hide Rulers. . . . . . . . . . . . . . . . . . . . . . . Ctrl+R
Change to Artboard Rulers . . . . . . . . . . . . . Alt+Ctrl+R
Show or Hide Bounding Box  . . . . . . . . . Shift+Ctrl+B
Show or Hide Transparency Grid  . . . . . . Shift+Ctrl+D
Show or Hide Text Threads . . . . . . . . . . . .Shift+Ctrl+Y
Show or Hide Gradient Annotator . . . . . . . Alt+Ctrl+G
Show Live Paint Gaps. . . . . . . . . . . . . . . . . . . . . . . . . . . .
Show or Hide Guides . . . . . . . . . . . . . . . . . . . . . . . Ctrl+;
Lock Guides. . . . . . . . . . . . . . . . . . . . . . . . . . .Alt+Ctrl+;
Make Guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+5
Release Guides . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+5
Clear Guides . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Smart Guides  . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+U
Show or Hide Perspective Grid . . . . . . . . . Shift+Ctrl+I
Show or Hide Grid . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+”
Snap to Grid . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+”
Snap to Point . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+”

Window
New Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Workspace > Save Workspace . . . . . . . . . . . . . . . . . . . .
Extensions > Kuler. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Actions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Align  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+F7
Appearance  . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+F6
Artboards . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Attributes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+F11
Brushes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F5
Color  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F6
Color Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+F3
Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Document Info . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Flattener Preview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Gradient  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+F9
Graphic Styles  . . . . . . . . . . . . . . . . . . . . . . . . . Shift+F5
Info. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+F8
Layers  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .F7
Links . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Magic Wand . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Navigator. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

 . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+F9
Separations Preview . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Stroke  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+F10
SVG Interactivity. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Swatches . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Symbols  . . . . . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+F11
Tools. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Transform . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Shift+F8
Transparency  . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+F10
Character. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+T
Character Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Glyphs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
OpenType . . . . . . . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+T
Paragraph . . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+T
Paragraph Styles . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Tabs . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+T

Other Panels
New Symbol . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F8
Add New Fill . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+/
Add New Stroke . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+/
New Layer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Ctrl+L
New Layer with Dialog  . . . . . . . . . . . . . . . . Alt+Ctrl+L
Switch Units . . . . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+U
New File (No Dialog) . . . . . . . . . . . . . . . . . . Alt+Ctrl+N
Close All . . . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+W
Cut, Copy, Paste (Secondary). . . . . . . . . . . . . . F2, F3, F4
Debug Panel . . . . . . . . . . . . . . . . . .Alt+Shift+Ctrl+F12 

Other Text
Insert Hyphen. . . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+-
Point Size Up. . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+>
Point Size Down . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+<
Font Size Step Up . . . . . . . . . . . . . . . Alt+Shift+Ctrl+>
Font Size Step Down . . . . . . . . . . . . Alt+Shift+Ctrl+<
Kern Looser . . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+]
Kern Tighter . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+[
Tracking. . . . . . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+K
Clear Tracking . . . . . . . . . . . . . . . . . . . . . . . . Alt+Ctrl+Q
Spacing . . . . . . . . . . . . . . . . . . . . . . . Alt+Shift+Ctrl+O
Uniform Type . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+X
Left Align Text . . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+L
Center Text . . . . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+C
Right Align Text . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+R
Justify Text Left . . . . . . . . . . . . . . . . . . . . . Shift+Ctrl+J
Justify All Lines. . . . . . . . . . . . . . . . . . . . . .Shift+Ctrl+F
Toggle Auto Hyphenation . . . . . . . . Alt+Shift+Ctrl+H
Toggle Line Composer . . . . . . . . . . . .Alt+Shift+Ctrl+C

Help
Illustrator Help . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . F1
Welcome Screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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